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NEW FUNCTIONALITY OF TDIWIZ 1.2 

The essential innovations with the current release of TDIWiz are: 
 

¶ Text Modules 
Text modules can be used in conjunction with the professional version and are much 
more than simple boiler plates. They enable the user to store text content as well as the 
corresponding processing rules within the TDIWiz database and use them for insertion 
into other templates.  By using this functionality youôve to perform changes only once and 
can apply them with one call to a great number of templates. 

¶ New Administration AddIn 
The new AddIn includes the TDIWiz Ribbon and the Administration Task Pane. Via 
ribbon the task pane can be activated/deactivated for each template. Furthermore 
TDIWiz processing for the current document and insertion of a text module may be 
initiated, too. By setting a registry entry, showing of the task pane can be suppressed 
generally. 

¶ Processing Options 
In the past, the editing screen of the processing options was shown every time when 
invoking the processing from the task pane. Now this screen must be invoked explicitly 

¶ Bookmark function 
Via Bookmark-function you can get the current content of a bookmark. 

¶ Additional parameter of CreateDocument-function 

In former TDIWiz versions the CreateDocument-function needed a template being stored 

in the file system. Now you may also specify a WordprocessingDocument-object as 

template. This enables to use TDIWiz for instance together with SHAREPOINT 

documents, too. 

¶ Only these input variables are shown  in the variable form, which are not already supplied 

by the calling program 

¶ GetDBField function 

This function enables to read data fields directly from a data base. 

¶ Enabled command 

Within a procedure being defined in conjunction with an input variable you may deactive 

and also activate again input fields of the form 

¶ IN-Operator with boolean expressions 

This enables to simplify checking one expression against several different values 
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INTRODUCTION 

Certainly the easiest and fastest way to get to know the possibilities offered by TDIWiz is to 
view the demo videos on www.tdiwiz.com or the ñHow toò description. It will also be helpful to 
look at and try the supplied sample documents (=> last chapter). This Program Description 
will give you more detailed information. The chapter Language Elements is only needed, if 
you want to define conditions or procedures. 

How TDIWiz works 

With TDIWiz you can create - without programming effort - documents or emails 
programmatically by populating predefined templates with data. 
 
To automate the creation of documents in conjunction with TDIWiz it needs to run only 2 
working steps: 
 

1. Design a template 
Designing, editing and testing of templates take place in the familiar environment and with 
the functionality of MS Word, assisted by the Administration AddIn. 

2. Run TDIWiz processing to create a new document or email 
The main task, the creation of a new document or email, is done by TDIWiz Component. 
Normally itôs initiated by invoking the CreateDocument function from the TDIWiz .NET dll. 
A sample project illustrating such an application is included in the setup file! Processing 
can also be initiated via TDIWiz AddIn for the active Word document. This possibility can 
be used for testing the template as well as for practical application. 

Application scenarios 

¶ Whereever the required task is to mix default text ñstructuresò with application data 
according to predefined rules; e.g. certificates, lists, invoices, order confirmations, etc. 

¶ Program-controlled sending of personalized (serial) emails 

¶ When developing solutions, the item ñdocument automationò, which, as it were, very often 
does not belong to core competences, may be neglected. It will do to provide a call to 
TDIWiz in your application, currently required documents or emails may be much more 
flexibly defined outside the application. 

Special strengths and benefits of TDIWiz 

¶ TDIWiz enables to use document automation without any coding 

¶ Though itôs very easy to use, you can accomplish even demanding tasks and do this 
within hours instead of days or even weeks. 

¶ Design and test of templates occur in the familiar enviroment and with the functionality of 
MS Word. 

¶ Text modules enable to store text content together with corresponding processing rules 
(e.g. conditions, procedures) for use in a great number of templates 

¶ Excellent performance 

TDIWiz versions 

TDIWiz can be used in 3 different versions with different functionality: 
 

1. TDIWiz Lite ï free of charge with restricted functionality 
2. TDIWiz Standard 
3. TDIWiz Professional 

http://www.tdiwiz.com/
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 Lite Standard Professional 

Automatic data mapping YES YES YES 

Conditional document ranges NO YES YES 

Repeat Blocks NO YES YES 

MailMerge functionality YES YES YES 

Procedures NO NO YES 

Predefined bookmarks NO NO YES 

Text modules NO NO YES 

 
When calling TDIWiz via administration task pane or using the free trial version, the 
functionality of the professional version is available! 

Different types of licensing 

Templates may be designed with assistance of the administration task pane without any 
license. 
 
Client- and Server-License are runtime licenses. The essential difference is that in 
conjunction with a Client license the new document will always be opened after creation by 
MS Word. 
 
Additional possibilities provides the DPL-License. Under such license you may ñsignò 
templates and deploy these templates to be processed without license. 

First Steps  

To get to know TDIWiz as fast as possible you have only to 
  
1. Installation  

2. Start MS Word (from version 2007)  

3. If the installation has been successful the ribbon TDIWiz will be shown  

4. Open the supplied sample documents (=> last chapter); the administration task pane will 
already be activated for all templates  

5. Invoke TDIWiz processing either via administration taskpane (TDIWiz) or via TDIWiz 
Ribbon (Run TDIWiz)  

 
Based on our long time experience, we are aware that some errors may have slipped in this 
manual. Please do not hesitate to inform us. It goes without saying that we are also very 
grateful for any ideas and suggestions that may contribute to the improvement of TDIWiz. 
  
 
Sklenar GmbH 
Software & IT Consulting 
Anton Baumgartnerstr. 44/C7 
A-1230 Vienna / Austria 
Email:  info@tdiwiz.com 
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INSTALLATION 

The downloaded zip-file includes Setup.exe und TDIWizSetup.msi. 
 
IMPORTANT  For setup you have to run the program Setup.exe. 
 
In order to use TDIWiz, you must have .NET Framework 3.5 installed on your machine. 
 
At beginning of Setup you may choose, if showing the administration task pane should be 
suppressed generally. In this case  only the functionality of the TDIWiz ribbon is available. If 
you want to change this back later on, you must only set the Registry entry 
 
 HKLM\Software\Sklenar\TDIWiz\ShowTaskPane 
 
to a value not equal ñ0ñ! 
 
TDIWiz is installed by default in the folder ñc:\Program Files\Sklenar\TDIWizò. Files, which 
must be changeable (license files, TDIWiz database, etc.) will be stored in a selectable folder 
(Default: c:\Users\Public) and corresponding subfolders. 
 
IMPORTANT  If you donôt accept this default folder, you have to adapt the file 
TDIDBConnection.ini appropriately! 
 
IMPORTANT  Registry entries will be created in the CurrentUser hive. If TDIWiz should be 
used also by other users you ve only to generate these needed entries via 
TDIWizAddInAddRE.exe! 
 
The following libraries/files are installed: 
 
System libraries 
 
There are some system libraries (e.g. interop-dll for Word, Outlook, etc.) needed by TDIWiz. 
These DLLs are added to the Assembly-Cache. 
 
Text.Data.Integration.Wizard.dll + Resources-DLL 
 
The TDIWiz processing component, which creates new documents or emails. It is mandatory 
and added to the Assembly-Cache. 
 
TDIWizAddIn (optional) 
 
AddIn, which handles the TDIWiz Ribbon and the Administration Task Pane. It can only be 
used from Word Version 2007. 
 
Miscellaneous 
 
TDIWizLicenseActivation.exe Program to activate license; must be used, if MS Word 

isnôt available 
TDIWizActualizeTextModules.exe Actualizes the text modules for all documents within a 

specified folder; must be used, if MS Word isnôt 
available 

TDIWizAddInAddRE.exe  Generates the needed CurrentUser registry entries for 
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 the current user 
TDIHelp.chm Help-File 
  
The following files will be installed within the changeable folder 
*.lic Files for licensing 
TDIDB.mdb Access file for speciific TDIWiz tables 
TDIDBConnection.ini Link to TDIWiz database; if the selected data folder isn t 

the default value Ăc:\Users\Publicñ corresponding 
modifications are necessary 

TDIWizTest Sample VB .NET project 
 
 
The  TDIDB database is only necessary, if you want to use predefined bookmarks or text 
modules, to store dataset definitions or to define additional system variables! 
 
Examples 
 
Sample documents plus input data, which demonstrate possible applications. 
 
 
IMPORTANT The license will be linked to the MAC address (Id of network adapter). If there 
will be a change you have to repeat the activation. For this case you need the original license 
file from setup. The license key will already be shown! 
 
 
To remove TDIWiz from a computer you have to run the uninstall-process of system 
administration. 

TDIWiz Database 

The TDIDB database will only be needed, if one of the following functionalities should be 
used: 
 

¶ Predefined bookmarks  

¶ Dataset definitions  

¶ Text modules  

¶ Additional system variables  
 
The database is linked via TDIDBConnection.ini, the access is made by OLEDB. 
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TDIWIZ ADMINISTRATION ï Design and test of templates 

 
Designing, editing and testing of templates take place in the familiar MS Word environment, 
the user is supported by the mandatory TDIWiz administration. It enables to 
 

¶ allocate input data 

¶ define the rules for document creation 

¶ an input form for variables may be defined 

¶ dataset definition files can be defined 

¶ administration of predefined bookmarks 

¶ edit processing options 

¶ administration of text modules 

¶ TDIWiz processing may be initiated for the active document 

¶ activate or view your license 
 
The administration component is part of the TDIWIZ AddIn and shown as task pane. It can only 
be used in conjunction with Word 2007. Activation/Deactivatiion of the task pane is initiated via 
TDIWiz ribbon. 
 

 
 
 

If only Word 2003 is available for designing the templates, you have to download the 
program TDIWizAdministration.exe and store it into the setup folder. 

Assign Input Data 

The assigned input data are used to populate the predefined template with actual contents. 
There are possible different formats: 

Activate/Deactiv
ate task pane 

Task Pane 
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XML  or SCHEMA file 
 
This will be the most popular format.In case of XML, you have to take care that a Schema 
definition exists, too. A Schema definition can be assigned implicitly by an identically named 
xsd-file or explicitly as parameter of the program call.  
 
Excel Worksheet 
 
The first row must include the column headers (= Name of datafield). 
 
CSV Format 
 
Character Separated Values (Tabulator or comma as separator) 
The first row must include the column headers (= Name of datafield). 
 
Dataset Definition 
 
Dataset definitions enable to access database date (from OLEDB databases) for populating 
a TDIWiz template. Dataset definitions can be saved as XML files or ï if a database is 
assigned - as entries of the TDIWiz database table TDIDataSets. To create/edit these 
definitions you have to call the administration menu item Extras>Datasets: 
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A definition file can include several databases and several dataset definitions! A dataset 
definition consists of one or more tables or views and optional of relations. With these you 
can get a hierarchical structur for the resulting XML data. In case of relations with more than 
one column, the column names must be divided by commas. The filter definitions may 
include place holders like ñ%$variablename%ò. They are substituted at processing time by 
the actual variable value! 
 
To edit an entry you have to double-click it or to call the context menu by right click. If the 
definition file includes more than one dataset definition, the assignment of the input data 
must have the format:  
 

File name(dataset name) 
 
IMPORTANT: For the internal processing, all none XML input data are converted to XML 
format! 

Define rules for document creation 

By designing a sample document you define the rules for processing by identifying with 
bookmarks the following: 
 

¶ What data should be mapped automatically to what positions of the template. 
 

¶ What document parts should appear only conditionally in the created document. This 
feature makes it possible to specify different text variants in the sample document and to 
activate/deactivate them depending on current data contents. 
 

¶ What document ranges are to be allocated to multiple data and duplicated depending on 
their number. Hierarchical data structures may be very easily reproduced by nesting such 
areas. 
 

¶ For special tasks, TDIWiz additionally provides the possibility to define procedures in an 
easy script language. These can be used to create bookmark content (e.g. calculations) 
or to set variables to control processing. When using this functionality, the developer is 
supported by a large number of powerful integrated functions. 

Input Variables 

You may define variables, which will be prompted from the user at start of processing via 
dynamically generated form. 
 
IMPORTANT:  Variables, which are already specified by the calling program are not 
prompted any more! 
 
To create/edit these definitions there are 2 possibilities: 
 

¶ Via menu item Extras>Variables 

¶ By assigning a variable to a document range: 
Select a range and click the menu item Assign Variable or ï if the assignement 
already exists ï by double-clicking the allocated bookmark entry 
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Name Unique variable name 
Type Character, numeric, integer, boolean, date 
Value Default value 
Format for numerical or date variables 
Max.Length Maximal input length 
Mandatory A value must be entered 
Multiline The input may include several lines 
Capital Letters The character input will be transformed to upper case 
Dropdown The user can select predefined values or enter own input 
Dropdown List Only the predefined values can be selected 
Selection The value of the variable will be set by selecting a row of an assigned 

table or view 
Caption Different caption, if not the variable name should be shown 
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Condition When leaving this input field, this logical condition will be tested. The 
variables must be addressed with $name, the current one can also be 
named with only $: 
$ <> $test3 means that input field test5 must be different to test3 

ToolTip Additional info shown with this field 
 
By clicking ĂUpñ and ĂDownñ you can change the order of input fields. 
 
By clicking Extras>Procedure an input mask is shown, in which a procedure can be assigned 
to the current variable. The procedure will be run when leaving the input field or ï with 
dropdown or checkbox controls ï when clicking the control. So you can make additional 
checks or set other input fields. In case that a procedure has been defined, the variable 
name is marked in the listing by the suffix ñ/Pò! 
 
By clicking ĂDropdown Definitionñ you can define the predefined list of values for a 
Dropdown(List)-field: 
 

 
 
The values can either be entered directly line by line or be defined by assignment of a 
database field. The database allocation may be realized via udl- (Linkfile) or ini-file (includes 
connection string) or by definition via MS datalink form. 
 
By clicking ĂDefine Selectionñ you can define the data source for the selection mask as well 
as the column, which should be taken. 
 
The following definition of a selection 
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will result in showing the following selection form 
 

 
 
and in loading the variable with the selected value of column CompanyName. 
 
IMPORTANT  Right-clicking a column header will enable to set a filter to this column. 

Create/Edit Templates 

Templates (TDIWiz sample documents) include all information TDIWiz needs - except of 
input data - for processing: 
 

¶ Fixed text parts that constitute the ñframeworkò of the document to be created 
 

¶ Bookmarks that determine the target location for automatic data mapping or define 
multiple, conditional or ñprogrammedò document parts. 
 

¶ Logical conditions, formatting information and procedures are saved in the document 
variables. 
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Templates can be stored in DOCX- or XML format of Word 2007, in XML format of Word 
2003 or in HTM format. If you want to create an email via call from an own program, you 
have to save the template as document in HTM format. The format can not be changed 
when creating a new document. 
 
A predefined template can be opened by File>Open. The existing bookmarks as well as the 
nodes of the allocated XML file are displayed as TreeView according to their structure: 
 
 

 
When double-clicking a bookmark node the relevant range 
will be selected. 
 
In addition, any additional bookmark characteristics are 
displayed in the colours red (conditions), blue (procedure 
commands) and green (format). Double-clicking displays the 
editing mask of the respective value. 
 
By selecting a bookmark entry with the right mouse button, 
several processing options are shown: 
 

¶ Deleting, moving or renaming (only bookmarks that 
are not allocated to any XML node) of the bookmark. 

¶ Assign a procedure 

¶ Assign a logical condition 

¶ Assign an input variable 

¶ Assign a format 
 
 
 
 
 
 
 

 
 
To create a new sample document you have to assign at first an input file. 
 
The structure of the allocated XML file has to match the files used for processing. The data 
content is not important, however, the structure is necessary to ensure the setting of 
bookmarks. 
 
Automatic data mapping 
 
To import data automatically into the document during processing, assigned bookmarks must 
be defined in the sample document:  
 

1. Select the required range in the document. Punctual insertion may also be sufficient; 
however, it is better to already document the expected content as text (e.g.  CustomerId). 

2. In the table tab XML nodes, call the context menu and desired entry with the right mouse 
button and select Set bookmark. 
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A predefined bookmark with its attributes may be assigned as follows: 
Extras>PredefinedBookmarks>Select entry by right mouse button>Set bookmark 

 
The bookmark name, allocated by TDIWiz, is context-specific (= related to the higher-order 
repeat blocks) and unique. In the case of a multiple allocation of the same XML node, the 
bookmark  name is expanded by Ă__#ñ (#=1,2,..). 
 
ATTENTION: Ă-ñ in the node name will be changed to Ă___ñ (underscore for 3 times). If 
higher-order nodes also have to be included to receive a unique name, Ă/ñ is represented by 
Ă____ñ (underscore for 4 times). e.g.: Customer-Id/Name becomes 
Customer___Id____Name. This only affects the ñrealò bookmark name, but not the shown 
name in the tree view! 
 
ATTENTION: Bookmark overlap is not permissible. 
 
ATTENTION: In TDIWiz, MS Word bookmarks have a specific meaning. Therefore, it must 
be ensured that, in case of changes to sample documents, bookmarks are not unintentionally 
deleted or removed. 
 
Definition of repeat blocks 
 
The illustration of multiple data in the document is also realized by bookmarks. The assigned 
bookmark is duplicated depending on the number of nodes of the allocated data. 
 
The definition occurs as described in the previous point. 
 
ATTENTION: With multiple text-nodes, you have to allocate 2 nested bookmarks. The outer 
one will be duplicated, the other will get the node value. 
 
Repeat blocks may also be nested to easily illustrate multiple-step hierarchical structures. 
 
A good example of such an application is the supplied document ĂTDI_OrderListñ. The partial 
area OrderDetails is included in the Orders repeat block. 
 
IMPORTANT  In the specific case that the repeat block consists of only one single table row 
and the following row has the same number of columns and includes any text or bookmarks, 
no duplicating but overwriting will happen. 
 
IMPORTANT  At first repeat blocks should be defined and afterwards the included targets for 
input data. 
 
Definition of conditional ranges 
 
In many application cases, depending on current input data, different text variants are 
required. For instance, different wordings may be dependent on whether an XML node is 
available once or several times.  
 
To solve this task, TDIWiz makes it possible to allocate logical condition for text areas: 
 

1. Selecting the text area in the document. 
2. Menu Condition 
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3. Input of logical condition in top right field of the following mask: 
 

 
 
If a bookmark already exists, the displayed condition for the editing mask may be accessed 
by double-clicking, too. 
 
The possibilities to define logical conditions are described in chapter Language elements. 
Application examples can be found in the sample document TDI_MailMerge. 
 
To simplify the input of XML names (use of capitals and small initial letters), variable names 
and function calls, and to reduce sources of error, these may also be imported by double-
clicking the relevant entry in the left field: 
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With functions, only one sample call instruction is inserted. The needed parameter values 
must still be entered afterwards. 
 
Procedures 
 
Sometimes, it is very time-consuming to supply all variable data to be inserted in the required 
form to the input data. In particular, this would also often entail an excessive orientation to 
the respective ñdocument logicò and prevent that users limit themselves to ñleanò, generally 
usable input data. 
 
To solve this problem, TDIWiz makes it possible to ñprogramò contents via procedures. 
 
Input/editing occurs in the previously displayed mask in the large lower right field. The 
simplifying items listed in the previous point may be applied, too. Additionally, the input help 
also applies to commands. 
 
Start procedure 
 
The start procedure runs at beginning of processing. With mail merge tasks, it runs before 
each individual element. It is used for the definition and value allocation of variables that may 
be used in all other procedures. 
 
The definition or change of start procedure may be accessed via menu Edit>Add/Edit start-
procedure. In case of changes, you have only to double-click the entry. 
 
An example is TDI_MailMerge. A variable is set, which shows, what language should be 
used for the single customer: 
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Other procedures 
 
This makes it possible to determine the content of the assigned bookmark. Text rows that 
are passed during processing are imported into the bookmark. 
 
Definition: 
 

1. Select text area in the document. 
2. Menu item Procedure 
3. Row-by-row input of procedure 

 
If a bookmark already exists, the editing mask for the procedure may be accessed by double-
clicking the entry. 
 
The possibilities of procedure content are described in chapter Language elements. 
Application examples can be found in Sample documents in First Steps. 
 
When defining a condition or a procedure, for the allocated document range a bookmark is 
added, too.The automatically generated bookmark name starts with TDI_CC_BM. If you 
would prefer self-documenting names, you should rename these bookmarks. 
 
Assign an input variable 
 
You can also assign an input variable to a document range: 
 

1. Select text area in the document. 
2. Menu item Assign Variable => Variable-form 
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3. Assign an already existing or new defined variable in the variable-form 
4. Exit variable-form 

 
The result depends on the type of the variable. If itôs a boolean variable the allocated text will 
be eliminated in the āFalseó-case (variable is not checked).With other types the value of the 
variable will be inserted at the allocated place. 

Predefined bookmarks 

The professional version enables to store the possible bookmark attributes (procedure, 
condition, format, input variables) together under an unique name in a database. When 
designing a template you may assign these entries. In this case, for future processings 
always the current definition will be applied! 
 
Definition of predefined bookmarks 
 
If the file TDIDBConnection.{udl|ini} is linked to a database with the table TDIBookmarks, 
than you may invoke the administration mask by Extras>Predefined bookmarks. 
 
Possible actions: 
 

¶ Add a bookmark entry (call via menu item) 
The following possibilities can be initiated via context menu (right mouse click) 

¶ Remove, copy or rename a bookmark entry 

¶ Add or remove a bookmark attribute 

¶ Edit an attribut (double clicking) 

¶ Enter a description for an entry 
 
Assign a predefined bookmark 
 

1. Select the wanted document range 
2. Extras>Predefined bookmarks 
3. Right-clicking the wanted bookmark entry 
4. Set bookmark 

 
IMPORTANT  At the begin of processing all defined input variables will be shown together in 
one mask! 

Activate or view license 

Activating or viewing the license can be initiated via Extras menu item. To activate the 
license via the TDIWiz activation server you need a serial number  for the appropriate license 
type. For activation on a computer without MS Word (e.g. server) you have to call the 
program TDIWizLicenseActivation.exe! 
 
IMPORTANT The license will be linked to the MAC address (Id of network adapter). If there 
will be a change you have to repeat the activation. For this case you need the original license 
file from setup. The license key will already be shown! 
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HOW TO CALL TDIWiz PROCESSING 

The real work ï creation of documents or emails - is done by the TDIWiz Component, a .NET 
dll. Mandatory parameters are only the sample document and input data. In the rare but 
possible case, that only variables should be used to modify the template, even the 
declaration of input data can be missing. There are 2 possibilities to start the creation of a 
new document: 
 
1. From the TDIWiz AddIn 
2. From own applications 

InvokeTDIWiz processing from the TDIWiz AddIn 

By clicking the menu item TDIWiz in the administration task pane 
 

 
 
or Run TDIWiz in the TDIWiz ribbon 
 

 
 
TDIWiz processing of the current document will be initiated. 
 
The first call option enables immediate testing of templates and also to use TDIWiz for free. 
 
Extras>Optionen => the editing screen of the processing options is shown: 
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Input-File  Indicates current input file; this value can not be changed when an EXCEL 
worksheet, a dataset definition file or a CSV file is assigned. 
 
Filter  Filter in XPath format for the XML data 
 
Mailmerge-Node  If this option is selected, a ñserial letter/emailò is created based on 
this XML node. If, for instance, ñCustomersò is entered, the current template is 
processed for each individual customer node. With XLS or CSV files the default value 
is datarow, because this is the name, automatically assigned at transformation. 
 
Condition  Specifies a logical condition (=> Language elements) for the single mail 
merge element. If ñ?ò => a selection mask is shown 
 
Mailaddress node  If this option is selected and ñE-Mailsò is checked, the resulting 
document is sent as an email via Microsoft Outlook®. The value of the allocated XML 
node is used as an email address. Personalized serial emails may thus be created in 
connection with the mailmerge node. 
 
Mail subject  Only in connection with sending emails via Outlook. Specification of 
message subject.  
 
Emails  if not checked => Mailaddress node and mail subject will be ignored. No mail 
will be sent. Restriction:  Emails must not include graphics or pictures. 
 
OnlyDraft  Only in connection with sending emails via Outlook. Messages are not 
sent, but only stored in the ñDraftsò folder. They may therefore still be checked or 
edited in the outbox before being removed. 
 
Read receipts  with emails. 
 
Show used time ï Displays processing time (without the opening of the result 
document in Word) in seconds. 
 

Invoking TDIWiz from an application 

The following code samples are Visual Basic. 
 
IMPORTANT: It is necessary to create at first a link to the .NET-DLL 
Text.Data.Integration.Wizard.dll.  
 
With 
 

Dim tdiwiz As New TDIWiz.Component 
 
a TDWiz object is created. The methods and attributes can then be addressed: 
 
Methods and attributes of TDWiz object 
 
When invoking TDIWiz you can use the 2 functions CreateDocument and SetVariable: 
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tdiwiz .CreateDocument(Template, SaveName, Filename[, XMLFilter] [, Document]) 

 
The selected TDWiz sample document Template is filled with data from Filename. XML data 
may, however, also be supplied directly as string to Filename. 
 
The result document is saved as SaveName, whereby the file type (docx, xml, htm) must 
not be changed. In the client version, SaveName is not necessary, because the created 
document is displayed by MS Word anyway. 
 
Input data may be restricted (e.g.: //Customers [CustomerID='BERGS']) by specifying 
XMLFilter. 
 
With Document you can also specify a WordprocessingDocument object as template. The 
Template value will be ignored in this case! So you have now the possibility to use also 
templates for TDIWiz processing, which are not stored in the Windows file system (e.g. 
Sharepoint documents). This parameter will return the resulting document, too! 
 
CreateDocument returns a Boolean value, showing whether processing could be processed 
without errors. In case of error, the attribute ErrDescription includes an error description. 

 
tdiwiz .SetVariable(VariableName, [VariableType], VariableValue) 

 
This method enables the supply of variable values to TDIWiz: 
 
ñCò (Character) is taken as default type (=> Chap.Variable). 
 
In addition, the TDIWiz object provides the following attributes: 
 
XMLSchema 
 
Specification of an appropriate XML schema. Either by specification of the name or as 
character string including the content. 
 
Only in conjunction with XML input data! 
 
MailMergeNode 
 
Specification of node name that determines the creation of serial letters/emails. The sample 
document is processed for each individual node. 
 
MailMergeCondition 
 
The specification of a logical condition (=>) that must be fulfilled for an individual serial 
element (e.g.: PostalCode = ñ1000ñ and Country = ñAustriañ). 
 
MailAddressNode 
 
Specification of the name of the text node containing the email address. 
 
If there is no email address for individual nodes, these serial elements are skipped. 
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ATTENTION: When creating emails, the sample document must be available in ñ.HTMò 
format, except when calling from the administration. 
 
AdditionalMMTemplate 
 
In the previously described case (serial mail with missing email address), an additional serial 
letter is created for all recipients omitted during mailing (=> Example TDI_MailMerge) upon 
allocation of a 2nd sample document. 
 
MailAttachments 
 
Specification of files (separated by comma), which should be sent as attachment of the 
email. 
 
DatasetName 
 
If the input data is a dataset definition with more than one dataset, you have to specify the 
wanted entry in this attribute. 
 
SMTPMail 
 
If you donôt want to send an email via Outlook but via SMTP, you have to set this boolean 
attribute to ñTrueñ. 
 
SMTPCredentials 
 
Needed for sending emails via SMTP. It must string including: 
 
Outbox server,emailaddress sender,password 
 
OnlyDraft 
 
When creating emails, the generated messages are saved in the ñDraftsò folder of Outlook. 
They may thus still be checked and edited before sending if necessary. 
 
Subject 
 
Specification of email message ñsubjectò. This value may also be set within a procedure 
through allocation to the variable $Subject (e.g. $Subject = ñTest-Mailñ). 
 
ReadReceiptRequested 
 
Only with emails. 
 
TDIDBConnection 
 
Link to a TDIWiz database (=> predefined bookmarks, additional system variables, dataset 
definitions). Specify an UDL- or INI-file or supply the needed connection string. 
 
 
ATTENTION: The setting of attributes and variables must occur before calling the function 
CreateDocument. 
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Example of TDIWiz call (VisualBasic code): 
 
Dim td As New TDIWiz.Component   Create TDIWiz object  
td.MailMergeNode = "Customers"   Nodes for serial letter 
td.SetVariable "Test", "C", ñTest variable contentò Character variable 
td.CreateDocument (ñc:\tmp\tditemplate.docxò, "", ñc:\tmp\tdiinp.xmlò) Run processing 
If td.ErrDescription <> "" Then    OK? 
    MsgBox td.ErrDescription    No => Error message 
End If 
Set td = Nothing     TDIWiz object released 
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TEXT MODULES 

This functionality enables to store often needed document parts in the TDIWiz database and 
to insert these text modules in your documents whenever you need. The stored information 
includes not only the text content (boiler plate), but the rules for TDIWiz processing, too. 
Changes have only be made once and can be applied to all the templates programmatically. 
 
IMPORTANT  The text module entries are dedicated to a specific format (2003, 2007) and 
can only be used in conjunction with documents of this format. The HTM format isnôt 
supported. 
 
IMPORTANT  The current release doesnôt support text modules including graphics or 
images, which are stored together with the document! 
 
IMPORTANT  For using this functionality the TDIWiz database must contain the tables 
TDITextModules and TDITMRelations! 

Store new text module 

Click Extras>Text modules>Add new text module in the administration task pane. 
 
Take care that 
 

¶ the document must be saved 

¶ a text module of this name must not exist neither in the database nor in the document 
 
The document range of the text modul will be marked by the bookmark 
TDI_TM_textmodulename. 
 
Text modules may be nested. 

Insert a text module 

Click Insert Text Module in the TDIWiz Ribbon or Extras>Text modules>Insert text 
module in the task pane. 
 
For selection only entries with the corresponding document format (2003 or 2007) will be 
shown! 
 
If the current selection and the text module arenôt ñcompatibleñ youwill get an error message. 
Thatôs for instance if the text module includes whole paragraphs, but should be inserted as 
part of a paragraph. 
 
Insertation of a text module can be repeated, the names of the bookmarks will be adapted 
accordingly. 

Actualize text modules in the current document 

Can be invoked via ribbon as well as via task pane. 
  
The text modules of the current document will be actualized that means that you will get the 
present state of the database entry. 
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Save text module 

Can be invoked via task pane. The current content of the corresponding bookmark will be 
stored in the database. The text module may occur only once in the document. 

Change a text module 

For the moment, this task can only be accomplished by 
 
 Insert the text module 
 Make the changes 
 Save the text module  

Administration of text modules 

Can be invoked via task pane. 
 
In this screen you can delete or copy entries. 
 
First of all you can invoke the actualization for all documents of a specified folder. 
 
IMPORTANT  For using this functionality you need either a server or a DPL license! 
 
IMPORTANT  This task can also be done by TDIWizActualizeTextmodules.exe. 
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TDIWiz LANGUAGE ELEMENTS 

This chapter is only relevant, if the features conditional text parts and/or procedures are 
used. 

Expressions 

Expressions are used to specify parameter values in commands, functional calls, and logical 
conditions 
 
Expression: 
 
exp1 [ & exp2] ... [ & expn]  
 
expn { nodes | variable | literal | spec.char | number | function | num.exp } 

    
 
nodes XML data may be addressed in different ways: 
  
 Node name 

 
The search for required nodes depend on the current ñcontextò, i.e. whether 
the current bookmark lies within repeat blocks or not. 
 

1. Within nested repeat blocks: 
The XML nodes allocated to individual repeat blocks are searched for 
node name from inside to outside. The name must be unique. The 
name path must be indicated in such a way that this is ensured (e.g.: 
Sales/Name and Support/Name in repeat block Customer). 
 

2. Outside repeat blocks: 
The search for a unique node name is carried out in the entire XML 
data area or in the area limited by the XMLFilter. 

  
 XPath expression 

 
XPath expressions are characterised by the fact that they start with Ă<ñ and 
end with Ă>ñ. 
 
Variable parts of the expression to be dynamically determined may be defined 
in two ways: 
 

1. Placeholder (limited by Ă%ñ) 
<//Employees[EmployeeID=%$EmployeeID%]/FirstName> 
%$EmployeeID% is replaced by the value of the variable 
 

2. The entire expression is indicated as expression: 
<ò//Employees[EmployeeID=ò & $EmployeeID & ñ]/FirstNameò> 
$EmployeeID is replaced by the variable value 
 

Both cases lead to the same result. 
 
Similar to the specification of a node name, the search is carried out context-
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related in XPath expressions. 
  
 Within a combined expression or a character string, the nodes result may not 

contain more than 1 node. In some functions (e.g. Max, Min, Sum, etc.) or in 
the DoNodes command, it may be the case.  
 
ATTENTION: Observe the use of capital and small initial letters when 
specifying the node name. 

 
  
variable In variables, an ñ$ò must be set before the name (Ă$CustomerIdñ). 
  
literal Literals are limited by double inverted commas (e.g.: ñExample:ñ) 
  
spec.char Not representable signs may be called via the Chr function (=> Functions). 

However, a few can be called more easily: 
  
 {EM} End mark 
 {LF}, {NL} New line (Line Feed) 
 {CRLF} Carriage Return + Line Feed 
 {TAB} Tabulator 
  
number Numeric constant 
  
function => chap. Functions 
  
num.exp Numeric values that are represented by data fields, variable, numbers or 

function values, linked by operators +, -, * and /. 
The processing order may be influenced by setting parentheses. 

 
Logical condition: 
 
logical expression1 [{ AND | OR  } log.exp2 ]  ... [{ AND | OR } log.expn ] 
 
logical expression: [NOT] exp1 [relational operator exp2] 
 
Relational operator:   { = | < | > | <= | >= | <> | IN } 

In cunjunction with operator IN you can add more than one 
comparative values: 
Name IN (ñSmithò,òMillerò) will have the same effect as 
Name = ñSmithò or Name = ñMillerò 

Variables 

Variables especially make it possible to also access and control current processing from the 
calling program. Additionally, information may be exchanged between procedures and logical 
conditions. 
 
Definition and scope of validity 
 
A variable is defined either via the SetVariable method of the TDIWiz object or within a 
procedure by the command 
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Vardef name1/type1[,name2/type2] .. [,namen/typen] 
 
name unique name 
  
type C(haracter), N(umeric), D(ate), T(ime), B(oolean) 
  
 
Scope of validity: 
 
Variables defined with SetVariable from the calling program and input variables remain valid 
until the end of processing. 
 
Variables defined during the start procedure remain for the current element (individual serial 
letter or entire processing). 
 
Variables defined in other procedures are released again at the end of the procedure. 
 
ATTENTION: The variable name must be unique. The definition of an already existing valid 
variable results in an error. 
 
Dynamic call of variables 
 
It is often an advantage to specify the name of a variable in such a way that it receives its 
current value at the time of processing: 

 
$name part1(exp for the rest of the name) 

 
The following examples should better illustrate the functional mode: 
 
Expression equals 
  
$Test(1) $Test1 
$Te(Ăstñ) $Test 
$Test($i + 2)       (with $i = 1) $Test3 
$(ĂTeñ & Ăstñ & $i + 1) $Test2 
 
Value allocation 
 
The allocation of a value to a variable may occur through 
 
1. The calling program with the method SetVariables 
2. Direct allocation - $variablename = exp 
 
System variables 
 
A few variables are also available without definition. The names of these ñSystem variablesò 
may not be used for own variables: 
 
COUNT Number of sets of current data source 
  
DATE Current date 
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ISMAIL Is set to TRUE, if an email is created 
  
NODENR Number of current node 
  
NR Number of the current node (repeat or MailMerge node); nodes that do not fulfil 

a prescribed logical condition are not included in the count. 
  
SUBJECT Subject of a mail message 
  
TEMPFOLDER Temporary folder 
  
TIME Current time 
 
IMPORTANT  If a database is allocated by TDIDBConnection.{ini|udl} and includes the table 
TDISystemVariable => a variable for each entry will be created! 

Commands for the logical control of procedures 

The logical progress within procedures may be controlled with the help of commands: 
 
 IF logical condition1 THEN 
    ...  
 [ELSEIF logical conditionn THEN] 
    ... 
 [ELSE] 
    ... 
 END IF 
 
As soon as a logical condition is fulfilled, the commands after it are executed. If no condition 
is fulfilled, the ELSE branch takes over. 
 
 DO [UNTIL logical condition] 

   ... 
LOOP [WHILE logical condition] 

 
The commands between DO and LOOP are processed in a loop until an UNTIL condition is 
fulfilled, a WHILE condition is no longer fulfilled or the routine is terminated with EXIT DO. 
 
 DONODES nodes 

   ... 
NODESLOOP 
 

The commands between DONODES and NODESLOOP are processed in a loop for all 
nodes defined with nodes. The routine may be terminated prematurely with EXIT DO. 
 
 SELECT CASE exp 

CASE { value1..[,valuen] } 
   ... 

 [CASE { value1..[,valuen]  }] 
   ... 

 [CASE { ELSE }] 
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   ... 
END SELECT 

 
As soon as a CASE value matches the value of exp, the commands behind it are executed. If 
no condition is fulfilled, the ELSE branch takes over. 
 

Other commands 

Commands are indicated as separate procedure line. 
 
Enabled var,{True|False} (De)activate input field  
 
This command can only be used within a procedure defined in conjunction with an input 
variable. It enables to deactivate (False) input fields of the current form and to activate (True) 
them later on again. 
 
ErrMsg exp Cancel with own error message  
 
The processing with TDIWiz is aborted with the error message exp. In case of procedures of 
input variables only the message is shown. 
 
Exit [Do] Exit from procedure or DO loop 
 
VarDef name[/type] Definition Variable 
 
The name variable of type type (Std.= C(haracter)) is defined. 
 
 
ATTENTION:  Lines that start with a single inverted comma(ó) are interpreted as comment. 
 

Functions 

TDIWiz possesses a number of integrated functions that are supposed to make the 
developerôs work easier. Each function returns a value (character string, number, logical 
value) as a result. 
 
A few functions also exist in similar form in VBA (Visual Basic for Applications). 
 
Functions may be indicated in expressions within procedures and logical conditions.  
 
Abs(num.exp) Absolute value of exp 
 
Example:  Abs(5) = Abs(-5) = 5 
 
Avg(nodes[,exp][,filter]) Calculate average 
 
The average value of nodes  or of exp of nodes is returned. 
 
Bookmark(bookmark) Get bookmark value 
 
The current value of the specified bookmark will be returned. 
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CBool(exp) Conversion to logical value 
 
Example:  CBool(0) = False, CBool(num.exp) = True, if num.exp <> 0 
 
CDate(exp) Conversion to date value 
 
CDbl(exp) Conversion to double value 
 
IMPORTANT:  In XML text nodes, a Ă.ñ is always required as a decimal separator. 
 
Chr(integer) Character representation of an ASCII value 
 
Example:  Chr(13) corresponds to the end mark. 
 
CInt(exp) Conversion to integer value 
 
If exp is not an integer value, the result is rounded. 
 
Count(nodes [,filter]) Number of allocated XML nodes 
 
The number of nodes is returned. 
 
DateAdd(interval,count,date) Date addition 
 
interval => VBA 
 
DateDiff(interval,from,to) Date difference 
 
interval => VBA 
 
EndsWith(exp,string) Enquiry, if exp ends with string 
 
Results in True if exp ends with string, otherwise False. 
 
Format(exp,format) Formatting function 
 
Like the format function in VBA (=>). 
 
In the case of logical values, conversion into a character string is also possible: 
In this case, the formatting instruction must be exceptionally indicated without inverted 
commas; ĂTrueñ and ĂFalseñ strings must be separated by Ă/ñ. 
 
Example: Format(IsCorrect, correct/incorrect) => depending on whether or not the text node 
IsCorrect includes the logical value true or false, the functional result is  Ăcorrectñ or 
Ăincorrectñ. 
 
GetDBField(field,SQL command,DB connection) Read field from database 
 
The value of field of the first record of the recordset being specified by the SQL command will 
be returned. The database connection may be specified as UDL or INI file or directly via 
connection string. 
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Example: 
 
gtdbfield(ñCityñ,ñSelect * from Customers  where CustomersId = ñòBLAUSòòò, 
c:\tmp\Nordwind.iniò)  will return  ñMannheimò 
 
GetDocVar(variable) Read document variable 
 
The value of the desired document variable is provided. If the variable does not exist, an 
empty string is returned. 
 
InStr([start,]string,search) Search character string 
 
If the search character string search in string is included from the position start (Std: 1), the 
function returns the position of the 1st character as result value, otherwise the value 0. 
 
Example: InStr(ò0123123ñ,ñ1ñ) results in 2 
 
InStrRev([start,]string,search) Search character string 
 
Like InStr, however, the search is performed in the opposite direction. 
 
Example: InStrRev(ò0123123ñ,ñ1ñ) results in 5 
 
IsNumeric(exp) Check if numerical 
 
Left(exp,count) Beginning of character string 
 
Example:  Left(ò12345ñ,3) supplies the result Ă123ñ 
 
Len(exp) Length of character string 
 
List(nodes[,exp][,del][,lastdel]) List 
 
The content of text nodes nodes or exp of nodes is listed. For separation, del (default.: ñ ñ) is 
inserted, before the last element, lastdel. 
 
Example: List(ñTestñ, ñò, ñ, ñ, ñ and ñ) results in ñtest1, .., testn-1 and testnò 
 
LTrim(exp) Eliminate leading empty spaces 
 
Example:  LTrim(ò   abcñ) results in Ăabcñ 
 
Max(nodes[,exp][,filter]) Maximum value  
 
The maximum value of nodes or of exp of nodes is returned. 
 
Mid(exp,start[,count]) Partial chain 
 
From position start, count characters are supplied by exp. If the count specification is 
missing, the entire remainder is supplied. 
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Example:  Mid(ò123456ñ,3,2) results in Ă34ñ 
 
Min(nodes[,exp][,filter]) Minimum value 
 
The minimum value of text nodes nodes or of exp of nodes is returned. 
 
Replace(exp,oldvalue,newvalue) Replace character string 
 
In the character string exp, all occurring oldvalues are replaced with newvalues.  
 
Example:  Replace(ò123451ñ,ñ1ñ,ññ) results in Ă2345ñ 
 
Right(exp,count) End of character string 
 
Example:  Right(ò12345ñ,2) results in Ă45ñ 
 
Round(exp,count) Round decimal value  
 
count indicates the number of decimal places that must be rounded.  
 
Example:  Round(123.456) results in Ă123.46ñ 
 
RTrim(exp) Eliminate final empty spaces 
 
Example:  RTrim(òabc   ñ) results in Ăabcñ 
 
 
StartsWith(exp,string) Enquiry, if exp starts with string 
 
Results in True if exp starts with string, otherwise False. 
 
Sum(nodes[,exp][,filter]) Sum of allocated text nodes 
 
The sum of numerical text nodes nodes or of exp of nodes is returned. 
 
SumBookmarks(bookmark) Sum of allocated bookmarks 
 
The contents of bookmark are added within the current context (=> Example and description: 
TDI_OrderList). 
 
Trim(exp) RTrim + LTrim 
 
Both leading and final empty spaces are eliminated. 
 
Example:  Trim(ò   abc   ñ) results in Ăabcñ 
 
UCase(exp) Conversion to upper case 
 
Example:  UCase(òabcdñ) results in ĂABCDñ 
 
VariableExists(variable) Check whether document variable exists 
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Results in True if the document variable variable exists, otherwise False. 
 
Weekday(date) Day of the week 
 
Returns the weekday of date as digit: 
 
 1 = Sunday 
 2 = Monday 
 3 = Tuesday 
 4 = Wednesday 
 5 = Thursday 
 6 = Friday 
 7 = Saturday 



 Program description 
 

GET TO KNOW TDIWIZ BY EXAMPLES Page 34 
 

GET TO KNOW TDIWIZ BY EXAMPLES 

The easiest and fastest way to get to know the essential functionalities of TDIWiz is certainly 
to view the demos on www.tdiwiz.com. Another very helpful method would be to study the 
supplied sample documents. 
 
With this application examples, using the Microsoft sample database NORDWIND, the dry 
theoretical listing of the TDIWiz functionality is to be supplemented with additional ñlivingò 
visual material. 
 
Examples may not always be related to the readerôs own requirements. By demonstrating the 
main TDWiz functionalities, however, they show methods as to how the required results may 
be achieved. 
 
There are only a few steps to get going and to run the examples: 
 

1. Run Setup.exe 
  

2. Start Word 2007 
 

3. Open (File>Open in the administration form) the wanted sample document 
 (folder = setup folder\templates) 
The existing bookmarks as well as the nodes of the allocated XML file are displayed 
as TreeView according to their structure: 
 

 
 
In addition, any additional bookmark characteristics are displayed in the colours red 
(conditions), blue (procedure commands) and green (format). 
 

4. By double-clicking an entry of the bookmarks treeview the assigned document range 
is selected. 
 
By double-clicking the coloured entries the edit mask for the selected value is shown: 

http://www.tdiwiz.com/

